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A B S T R A C T

Radon exposure is still a significant public health concern, particularly in regions where natural building ma
terials are derived from high-radiation subsoils. This study proposes a multidisciplinary protocol for assessing 
radon risk in existing buildings, with a specific focus on the municipality of Sant’Agata de’ Goti (southern Italy), 
a historical town built entirely of Campanian Ignimbrite tuff. Indoor radon concentrations were monitored using 
CR-39 detectors in 20 locations over a one-year period, revealing that 70 % of the measured values exceeded the 
regulatory threshold of 300 Bq/m³. Complementary analyses were conducted on tuff samples used as Building 
Materials (BMs), including gamma spectrometry, electret ion chamber, X-ray fluorescence (XRF), and scanning 
electron microscopy with energy-dispersive spectroscopy (SEM-EDS) measurements. High levels of Ra-226 and 
Th-232, along with elevated exhalation and emanation parameters, were observed. The study highlights how 
petrographic and mineralogical features - such as pumice porosity, zeolitization, and microstructure - enhance 
radon release beyond what is predicted by radionuclide content alone. The I index exceeded unity in both 
analyzed facies - the yellow one and the gray one of the Ignimbrite tuff - suggesting these materials pose a 
radiological hazard. The results highlight the need to integrate BMs characterization into National Radon Action 
Plans, particularly in areas with widespread historical use of volcanic tuff. This would include BMs already in use 
and not just those in pre-commercialization, as is required by current regulations. The proposed approach 
provides a replicable model for assessing radon risk in existing structures and supports targeted mitigation 
strategies based on multidisciplinary data.

1. Introduction

Exposure to ionizing radiation from both natural and artificial 
sources is an inherent part of life on Earth and a well-documented health 
risk (National Research Council 2006; UNSCEAR 2000). Natural radio
activity is the primary component of environmental background radia
tion, with radon being the largest contributor, accounting for about 50 
% (UNSCEAR 2008). Among the radioisotopes, of particular interest are: 
radon-222 (Rn-222), which derives from the decay chain of 
uranium-238 (U-238), has the longest half-life (3.82 days) and con
tributes 31.6 % to background radiation; and thoron (Rn-220), derived 
from thorium-232 (Th-232), with a half-life of 55.6 s, contributing 10 %. 

However, due to its relevance and abundance in the environment, 
Rn-222 is the only one conventionally considered.

Rn-222, the decay product of radium (Ra-226), is an inert gas and, 
due to its gaseous nature, can escape from the mineral structure and 
enter the rock pores. This process is known as emanation and constitutes 
the fraction that is potentially available for release into the external 
environment (exhalation process). The specific position of the decaying 
radionuclide and the recoil direction of the newly formed radon atom 
significantly influence emanation. Physical factors, including humidity, 
temperature, the distribution of radionuclides within the mineral 
structure, and pore characteristics, influence the emanation/exhalation 
process. (Sakoda et al., 2010). In fact, Rn can reach the atmosphere 
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depending on the matrix permeability, thus accumulating in closed 
environments. In addition to the aspects specifically related to the ma
trix, other main routes of entry and accumulation of radon gas indoor 
are cracks in foundations, walls and pipes, water systems (showers and 
taps), and building materials (BMs) (UNSCEAR 2008; Di Carlo et al., 
2023) Inhalation of Rn-222 poses a significant health risk [(Pawel and 
Puskin, 2004; World Health Organization (WHO) 2009; International 
Agency for Research on Cancer (IARC) 2012)]. The primary health risks 
associated with Rn-222 exposure, rather than from the gas itself, arise 
from its short-lived radioactive decay products, polonium 218 and 214 
(Po-218 and Po-214) (UNSCEAR. Sources 2012). Alpha decay from these 
isotopes can damage DNA, leading to mutations and an increased risk of 
lung cancer. Studies have shown a correlation of 3–14 % between lung 
cancer incidence and radon exposure [(International Commission on 
Radiological Protection (ICRP) 2014; Liu et al., 2024; Darby et al., 
2005)]. Due to the associated health risks, international and national 

regulations (Decreto Legislativo 31 luglio 2020; Council Directive 
2013/59/Euratom of 5 December 2013 2014) mandate the consider
ation of all potential radon sources, including BM. Over the years, the 
Italian government has adopted various Legislative Decrees (D.L.) for 
monitoring radon gas in buildings. In 2000, D.L. 241/2000 (Decreto 
Legislativo 26 maggio 2000, n. 241 2000) identified workplaces on 
ground floors and thermal baths as the scope of application. In 2020, D. 
L. 101/2020, implementing the European Directive Euratom 59/2013, 
introduced the principle of optimization in radiation protection through 
a gradual approach, extending the scope to dwellings. Furthermore, in 
compliance with the Directive (Article 103 and Annex XVIII), and 
similarly to other European countries, D.L. 101/2020 introduced a Na
tional Radon Action Plan (NRAP) (Ministero della Salute 2024) high
lighting the need for a specific plan to measure and monitor indoor 
radon (Silva et al., 2022).

Within the regulatory framework, BMs are only monitored to assess 

Fig. 1. A) Areas where the sampling was conducted (samples with radiometric anomalies). In yellow, sample SADG2; in grey, sample SADG2. b = alluvial deposits, 
b2 = eluvial and colluvial covers, TGC = Campanian grey tuff (ignimbrite), AQZ = Campoli sandstones, ALV = varicolored clays, CRQ = limestones with requienia 
and gastropods ( (Monti et al., 2011), (Carannante et al., 2011) modified; B) Stratigraphic column of the Campanian Ignimbrite (from (Cappelletti et al., 2003) - 
modified); C) Map of the 160 underground cavities in Sant’Agata de’ Goti. (b) Stratigraphic section of the historic center of Sant’Agata de’ Goti (from (Scotto di 
Santolo et al., 2014) –modified); D) Map of the CR39 detectors’ positioning in places from Google Earth™ Pro (modified), at different heights above the ground: S 
(basement), T (ground floor), P (first floor).
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radiometric suitability for marketing and ensure compliance with the 
standards of European regulation no 305/2011 (European Union 2011), 
excluding existing exposure scenarios from risk management. Regarding 
the NRAP, while the main objective is to identify high-risk radon areas 
and start actions to reduce exposure (Hodgson et al., 2011), there is also 
a need for radiological identification and characterization of BMs 
considering the radon exhalation rate (Action 2.3 NRAP).

This aspect requires the definition of shared and standardized 
experimental protocols to comply with the aforementioned requirement, 
which are still being defined today (Martell et al., 2023).

This work therefore addresses a current issue with seemingly few 
solutions, proposing, with experimental measures, an approach that can 
integrate regulatory requirements and good practices, aimed at guar
anteeing the maximum radiation protection possible.

The aim was to report a case study of existing exposure in a village 
entirely built on a volcanic tuff spur, Sant'Agata de' Goti (in Campania, 
southern Italy), which had been preliminarily investigated (La Verde 
et al., 2020). The implications are twofold: to highlight the need to 
consider existing exposure scenarios not covered by the legislation and 
to validate a multidisciplinary approach to radiometric characterization.

This methodological approach included: indoor radon measure
ments; measurements of gamma-emitting radionuclides, implementing 
a preliminary investigation (Pugliese et al., 2024); radon exhalation and 
emanation measurements; and chemical and morphological analyses. 
The results are promising for developing standardized operational pro
tocols for holistic radon risk management.

2. Materials and methods

2.1. Studied area: Sant’Agata de’ Goti

The study was carried out in the urban area of Sant’Agata de’ Goti, a 
village of Roman foundation in Campania (southern Italy),in the prov
ince of Benevento, on the western slopes of Mount Taburno (Fig. 1A). 
Two sampling sites were selected, for two lithotypes, similar to those 
used in the construction of the historic buildings (samples SADG1 and 
SADG2). The first, SADG1, near the area of Sopracampo, and the second, 
SADG2, in the town center of Sant'Agata dei Goti, between Viale dei 
Caduti and Viale Picone. From a lithographic point of view, they 
correspond to two different typologies of Campanian Grey Tuff: grey 
(SADG1) and yellow (SADG2) facies (Fig.1B). Three tuff samples were 
taken for each sampling point. This number, although limited due to 
landscape and land preservation constraints, is sufficient and represen
tative of the two types of BMs. The primary information on the collected 
tuff samples and the geology of Sant'Agata de' Goti is extracted from the 
explanatory notes of the Geological Map of Italy, Sheet 432 Benevento 
(Monti et al., 2011) and Sheet 431 Caserta Est [(Chiocchini et al., 2009); 
Fig. 1A]. The tuff on which the village stands and with which it is built 
can be classified as Campanian Grey Tuff, produced by the eruption of 
the Campanian Ignimbrite (De Vivo et al., 2001). 40-Ar/39-Ar analyses 
on Campanian Ignimbrite date the origin of the first eruptive phase to 
39.28±0.11 ka years ago (De Vivo et al., 2001). The fall deposit that 
constitutes the base of the Campanian Grey Tuff is composed of alkaline 
trachyphonolitic pumices (Di Girolamo et al., 1973). From the lowest to 
the highest level, both the presence and the size of dark pumices increase 
while lava and sedimentary fragments decrease. The superficial ignim
brite portion, and therefore the most exposed one, can take on a 
yellowish color. This yellow facies, not to be confused with the Nea
politan Yellow Tuff originated from an eruption 15,000 years ago, owes 
its color and more coherent consistency to the effect of a secondary 
lithification process, in most cases a zeolitization (Cappelletti et al., 
2003). Fig. 1B shows the stratigraphic column of the Campanian 
Ignimbrite at Sant’Agata de’ Goti village and below is a detailed 
description:

Coarse Pumice Flow (CPF) – The uppermost portion of the Campa
nian Ignimbrite is an incoherent unit composed of rounded pumice 

lapilli and clasts within abundant loose glass shards.
Lithified Yellow Tuff (LYT) – This locally occurring unit is a massive 

and lithified yellow ash deposit. It consists of an ash matrix with 
dispersed rounded pumice lapilli. Occasionally, a few coarse scoria 
fragments can be found. It rests on the WGI.

Welded Grey Ignimbrite (WGI) – A significant part of the Campanian 
Ignimbrite deposit consists of a grey ash layer ranging from a few meters 
to several tens of meters in thickness. The lower massive part (several 
centimeters thick) is white to cream-colored, relatively fine-grained, and 
contains scattered pumice lapilli and rare scoria lapilli towards the 
upper section. This lower part gradually darkens and transitions up
wards into a welded grey zone containing rounded scoria lapilli. This 
welded grey horizon is the most widespread facies associated with the 
Campanian Ignimbrite (previously known as Grey Tuff). It consists of 
black scoriae, reverse graded, embedded in an ashy matrix with subor
dinate lithics and crystals.

Unconsolidated Stratified Ash Flow (USAF) – This is a stratified and 
incoherent ash to sandy deposit, with colors ranging from whitish at the 
base to reddish at the top. Its thickness varies from a few centimeters to a 
maximum of about 50 cm. This unit contains scattered varying amounts 
of fine, rounded pumice lapilli. A laterally discontinuous level of the 
USAF is characterized by abundant lithics and crystals.

Plinian Pumice Fall (PPF) – The entire deposit is represented by four 
main layers, from A to D, from bottom to top, composed of pumice lapilli 
ranging in size from coarse to fine, along with smaller amounts of lithic 
clasts and crystals, except for layer C, which shows a marked enrichment 
in lithics and crystals. This sequence is capped by a thin stratified lapilli 
level that is sandy to fine-grained at the uppermost part (E); this layer is 
often eroded and directly underlies the ignimbritic succession.

The entire village is divided into two parts: a modern one, built 
starting from the late 19th century, and the other of Roman foundation, 
located on a tuff cliff and characterized by approximately 160 under
ground cavities (Fig. 1.C). These are the result of an ancient technique of 
quarrying tuff bricks, which were then used to construct the buildings 
above (Artiola et al., 2021; La Verde et al., 2021). Most of the village's 
houses rest directly on the tuff layer (LYT) and are built with tuff bricks 
extracted from the underlying layer of Campanian Ignimbrite.

This particular conformation makes the investigation of the distri
bution and concentration of indoor radon gas in these buildings even 
more interesting. Therefore, a survey was conducted by selecting the 
number of buildings in accordance with the NARP guidelines, which 
establish that the minimum number of measurement points, y, necessary 
to identify priority areas for radon risk can be calculated using the for
mula y = x^0.3, where x is the number of inhabitants. For a municipality 
like Sant'Agata de' Goti with 10,000 inhabitants (ISTAT 2025) the 
minimum number of buildings is 16. So, a total of 20 buildings were 
selected, 16 of which were located along the main and oldest artery of 
the village, built with tuff extracted from subsoil, and 4 in a newer 
building complex southwest of the town, including reinforced concrete 
structures, as shown in Fig. 1.D.

Although the intended use is not that of a living environment 
(ecclesiastical premises, shops, caves), the rooms are all exactly com
parable to domestic environments.

2.2. CR-39 for indoor radon survey

Passive CR-39 Solid-State Nuclear Track Detectors (SSNTDs) made of 
a plastic polymer called polyallyl diglycol carbonate were used for the 
survey. The detector is inserted into a conductive plastic chamber, 
which allows the radon to diffuse naturally within it. Once the radon gas 
decays inside the chamber, the alpha particles produced interact with 
the sensing material, damaging its chemical bonds and producing latent 
tracks (more details are reported in (Fews and Henshaw, 1982)). These 
tracks are made visible through chemical etching in a 6.25 M NaOH 
solution at 98 ± 1 ◦C for one hour, according to UNI ISO 11665-4: 2020 
(UNI ISO 11665-4:2020 2020).
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Subsequently, an automated microscopic image analyzer counted 
the track density (Sabbarese et al., 2020). Radon concentration (Rncon) 
was calculated using the following Eq. (1): 

Rncon= N / (E×T) (1) 

Where:
N is the track density corrected for background,
E is the calibration factor,
T is the exposure time.
The background track density was estimated at 10 tracks/cm2 based 

on unexposed detector counts. The measured track densities were con
verted into radon concentration by using the following calibration factor 
0.00209 ± 0.00021 tracks⋅cm2⋅h− 1/Bq⋅m3., determined through expo
sure to a certified atmosphere at the National Metrological Institute 
(ENEA) within the 100 to 3000 Bq h m3 range. The Minimum Detectable 
Activity (MDA) was estimated at 4 Bq/m3 with a 4320-hour exposure.

The CR39 were positioned inside the rooms at a height of approxi
mately 2 m from the ground and at least 0.5 m away from the sur
rounding walls to avoid the interference of thoron. Measurements were 
carried out for approximately one year, divided into two semesters: from 
18/07/23 to 20/11/23 (the first semester), and from 20/11/23 to 31/ 
05/24 (second semester).

2.3. Sample preparation for radiometric investigation

For each tuff sample, measurements were carried out both on the 
sample in its natural rock state (a cylinder approximately 8 cm in 
diameter and 1 cm high, same geometry as calibration source 
(Ambrosino et al., 2024)) and in a powdered form. To ensure a consis
tent and stable matrix, sample preparation followed the methodology 
outlined in UNI EN ISO 18589–2:2015 (UNI EN ISO 18589-2:2015 
2015). The rock cylinders were sealed in Marinelli beakers to prevent 
radon leakage prior to gamma spectrometry measurements, and to 
ensure the secular equilibrium between Rn-222 and Ra-226. ANGLE 
software of Ortec company were used to evaluate the detector efficiency 
with different geometries To obtain the other type of sample, instead, 
bricks were ground into powder, sieved, and dried in an oven at 105 ◦C 
for two hours. The powdered samples were then homogenized and 
weighed before being placed in Marinelli Beaker containers for four 
weeks to achieve secular equilibrium between Ra-226 and Rn-222. Both 
types of samples were used for gamma spectroscopy and exhalation 
measurements.

2.4. Gamma spectroscopy

A coaxial High Purity Germanium (HPGe ORTEC®) detector (model 
GMX-45P4ST) was used for high-resolution gamma spectrometry. The 
detector's specific characteristics were detailed in (Artiola et al., 2021). 
The detector is characterized by an energy resolution quantified by a 
Full Width at Half Maximum (FWHM) of 2.16 keV at 1.33 MeV, coupled 
with a relative efficiency of 48 %. The minimum detectable activity 
(MDA) calculated by the system has a 95 % confidence level (Currie, 
1968). Spectral data were acquired using the Ortec DSPEC-LF unit 
coupled with the MCA Emulator software, Maestro-32. Subsequent 
analysis was performed using GammaVision Spectrum Analysis Soft
ware, version 7.01. Counting times were set to 172,800 s (48 h) for 
samples and 259,200 s (72 h) for background, used for peak correction. 
A library of spectral lines for the major natural radionuclides, was used 
to analyze the spectra. The photopeaks used to determine the activity 
concentrations of Th-232 were the lines at 727.3 keV, 860.6 keV and 
911.2 keV of its daughters Bi-212, Tl-208 and Ac-228 respectively. The 
photopeaks used to determine the activity concentrations of Ra-226 
were the lines at 295.2 keV plus 351.9 keV and 609.3 keV plus 1120.4 
keV of its daughters Pb-214 and Bi-214 respectively. Final values of the 
activities concentrations of Th-232 and of Ra-226 where calculated with 

a weighted average of the values obtained from the respective de
scendants. The photopeak used to determine the activity concentrations 
of K-40 was the line at 1460.5 keV. For sample analysis, the 205.32 keV 
and 202.12 keV lines were excluded, and the 143.76 keV line for U-235 
was included to avoid interference from other radionuclides. A 1 L 
Marinelli beaker of liquid and sealed mixed nuclides standard source 
(Eckert & Ziegler Nuclitec GmbH) with an activity of 49 kBq, an energy 
range of 60–1836 keV, a density of 1 g/cm³, and a resolution of 3 % was 
used for energy calibration and efficiency determination. Other specific 
references are: MIX31520BD, type QCRB1244, serial n. BG-4358, 
drawing Vz-1520–001, calibration standard NG3–251. ANGLE soft
ware of Ortec company were used to evaluate the detector efficiency 
with different geometries and also for different matrix compositions in 
order to correctly evaluate the self-absorption effects (particularly for 
low-energy gamma photons Standard uncertainty was calculated ac
cording to the UNI EN ISO 18589-2:2015 (UNI EN ISO 18589-2:2015 
2015).

2.5. INDEX I

The Index I (I), introduced by RP 112 of 1999 (Commission, 2002) 
and then adopted at European and Italian level, is a screening tool 
generally used to carry out assessments of suitability for marketing and 
use of BMs. I is defined by the following Eq. (2): 

I =
CRa

300 Bq/kg
+

CTh

200 Bq/kg
+

CK

3000 Bq/kg
(2) 

In Eq. (2), CRa-226, CTh-232, and CK-40 represent the activity concen
trations of the corresponding radionuclides in the BMs, measured in Bq/ 
kg. Further details regarding the parameter values of 300, 200, and 3000 
can be found in reference (Markkanen, 1995). If I value is less than or 
equal to 1 (I ≤ 1), the material is considered suitable for unrestricted use. 
However, if I value exceeds 1 (I > 1), a more precise calculation of the 
gamma dose (D) is necessary. If the calculated dose exceeds the refer
ence level of 1 mSv/year, the material is deemed unsuitable for use in 
civil engineering structures, particularly residential and high-occupancy 
buildings.

2.6. Exhalation: sample surface area measurement

The lack of a standardized approach to expressing exhalation and 
emanation parameters is evident in both national and international 
literature (Sakoda et al., 2010; Ambrosino et al., 2024). These param
eters are often reported using a variety of metrics, including the 
emanation coefficient (as a percentage), surface exhalation rate 
(Bq/(m2⋅d)), and mass exhalation rate (Bq/(m2⋅d)). This multiplicity of 
approaches makes it difficult to perform a meta-analysis. However, to 
convert from one unit to another, only information regarding the sur
face, volume, mass, and sample density is needed (Nuccetelli et al., 
2020). In this work, therefore, the most commonly used exhalation 
parameters and the physical and geometric parameters necessary for any 
conversions are examined. In particular, a new protocol for measuring 
the emanation surface of irregularly shaped samples has been devel
oped. For porous and friable BMs such as tuff, in fact, it can be difficult to 
obtain samples with a perfectly regular shape and without 
macro-porosity, essential when calculating their volume and surface 
area using geometric formulas.

ImageJ software (NIH, Bethesda, MD, USA) was used for image 
analysis. The sample preparation steps before acquisition are reported 
below: 

1) Cover the sample with heat-shrinkable plastic and heat with a hot air 
gun until the plastic completely adheres to the irregular shape and 
macro-porosity of the sample.

2) Cover the plastic layer with a thin masking tape to create a thin shell 
that maintains the sample shape.
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3) Extract the sample from the plastic and paper casing using a box 
cutter. Make deliberate cuts to the casing to create a two-dimensional 
image of the sample's surface without compromising its integrity.

4) Capture an image of the flattened shell, placed adjacent to a ruler for 
scale.

5) Open the image in ImageJ; use the pointer to select the longest 
visible distance on the ruler in the photo, then go to the Analyze 
menu, select "Set Scale" and enter the measurement in cm as indi
cated by the ruler so that the software can convert pixels to cm.

6) Go to Image > Adjust > Color Threshold to highlight the edges of the 
surface. Then, use the wand tracing tool to select the exact contours 
of the surface.

7) Select Image > Adjust > Color Threshold to enhance the surface 
edges. Finally, use the wand tracing tool to accurately select the 
surface boundaries.

8) Select Analyze > Measure to obtain the surface area measurement in 
cm².

2.7. Exhalation: electrets ion chamber

NRAP outlines the 'identification of BMs with higher radon exhala
tion' as a key action (Ministero della Salute 2024). While the plan does 
not prescribe a specific protocol, it encourages the exploration of the 
most appropriate method for measuring radon exhalation parameters. 
The most recent ISO standards regarding the measurement of radon 
exhalation parameters are the ISO 11665-7:2012 standard and the ISO 
11665-9:2019 standard (UNI EN ISO 11665-7:2015 2012, UNI ISO 
11665-9:2019 2019). The first one concerns the measurement of the 
Rn-222 surface exhalation rate (expressed in Bq/(m²⋅h) over a short 
period of a few hours, at the interface of a medium with the atmosphere 
(soil or rock but can be extended to samples of BMs in general) and 
presents the difficulty of having an active monitor and a perfect airtight 
seal. The second method concerns the 'free exhalation rate' measurement 
(expressed in Bq/s) from samples of BMs, placed inside an accumulation 
chamber using passive detectors (activated carbon or silica gel) and 
requires sophisticated and expensive techniques such as Liquid Scintil
lation Counting (LSC) or gamma spectrometry (Nuccetelli et al., 2020; 
Poffijn et al., 1984; de Jong et al., 2005). For these reasons, the electret 
ion chamber has been considered among the most user-friendly in
struments for measuring the emanation/exhalation parameters of the 
Sant'Agata tuff. This device is readily available and relatively affordable, 
with its effectiveness supported by numerous studies (Moreno et al., 
2024; Kotrappa and Stieff, 2009; Righi and Bruzzi, 2006; Petropoulos 
et al., 2001). To measure the exhalation parameters, the tuff samples 
were placed at the bottom of an airtight jar with a volume of 3.843 L 
(Kotrappa and Stieff, 1994). Rock samples were mounted on small 
plastic pedestals to allow exhalation from their entire surface, while 
powdered samples were placed in metal cups to limit exhalation to the 
container's surface. At the top of the jar, connected to the inner part of 
the airtight cap, an E-PERM electret was connected in the short-term 
configuration (St electret and S chamber). Electret consists of an elec
trostatically charged Teflon plate with two different sensitivities (long 
and short term) attached to a diffusion chamber, also available in two 
configurations (long and short term). Air enters by passive diffusion in 
the chamber and, once equilibrium is reached, radon and its daughters 
decays by ionizing the air. The ions produced interact with the plate, 
discharging its surface voltage. The voltage difference allows the 
calculation of the radon activity concentration. More details are re
ported in (Rad Elec Inc 2024). Detectors were calibrated by participating 
in an international intercomparison (IRPA/AIRP 2024) where they were 
exposed to different of known radon activity concentrations and in 
constant environmental conditions (16.8 ÷ 30.5 ◦C, 965 ÷ 1008 mbar, 
and 2 humidity levels: 33.8 % ÷ 58.7 and 69.0 % ÷ 84.5).

To minimize relative error in activity concentration values and to 
prevent the negative impacts of back diffusion, which become signifi
cant after 6 days, a measurement period of 5 days was selected (Chao 

and Tung, 1999). A sample volume 10 times smaller than the jar's free 
volume is also sufficient to avoid the negative impacts of back diffusion 
(Krisiuk et al., 1971).

The exhalation rate can be derived from the measured activity con
centration within the jar, CRn (Bq/m3)by applying the following Formula 
(3): 

R(Bq /d) =
(CRn − CRn0)⋅V⋅0.1814

K
(3) 

Where: 

CRn= Average integrated activity concentration over exposure time 
(Bq/m3)
CRn0= Average integrated background activity concentration (Bq/ 
m3)
V= volume of air in the chamber (m3)0.1814 = decay constant of 
radon (1/d) 

K = 1 −

(
1 − e− 0.1814 T

0.1814 T

)

T= time of exposure (d).

Radon flux, F (Bq/(m2⋅d)), was calculated applying the Formula (4): 

F =
R
S

(4) 

Where S = sample surface (m− 2).
The mass exhalation rate, Rm, (Bq/(k⋅d) can be calculated applying 

the Formula (5): 

Rm =
R
m

(5) 

Where m is the sample mass.
The emanation coefficient, η, ( %) can be calculated applying the 

Formula (6): 

η =
Rm⋅100

CRa⋅0.1814
(6) 

Where CRa is the activity concentration of 226Ra of the sample 
measured with gamma spectroscopy.

2.8. Petrographic microscope

The petrographic microscope used is the AXIO IMAGER A1m by Zeiss 
powered by the Museum Center of Natural and Physical Sciences of 
University Federico II. The AxioCam ICc5 camera was used for image 
acquisition. The software used for image acquisitions is Axiovision SE64 
Ref 4.9.1. Petrographic observations were carried out on two thin sec
tions for each sample, obtained from different portions of rock collected 
at the two sampling sites, SADG1 and SADG2. Thin sections were 
examined to characterize not only the mineralogical composition of the 
samples but also their microstructural attributes, such as primary 
porosity, vesicles, and microfractures.

2.9. Scanning electron microscope - energy dispersive X-Ray spectroscopy 
(SEM-EDS)

Qualitative chemical analyses of the major and minor elements and 
detailed morphological characterization and qualitative chemical ana
lyses were performed by using a scanning electron microscope (SEM) 
JEOL-JSM 5310, coupled with energy dispersive X-ray spectroscopy 
(EDS), at the DiSTAR laboratories. The setup is equipped with an Oxford 
Instruments Microanalysis unit, INCA X-act detector, operating at 15 kV 
primary beam voltage, 50–100 mA filament current, variable spot size, 
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20 mm WD, and 40 s net acquisition real time. INCA X-act detector uses 
Energy software with XPP matrix correction scheme and Pulse Pile up 
correction. Detailed morphological observations and qualitative chem
ical analyses were carried out on two fragments for each sample, ob
tained from different portions of rock collected at the two sampling sites, 
SADG1 and SADG2. The analyzed samples were coated with Au.

2.10. X-Ray fluorescence (XRF)

Chemical analyses of bulk-rock powder samples SADG1 and SADG2 
were performed by X-ray fluorescence (XRF) using an Axios Panalytical 
sequential wavelength-dispersive spectrometer, equipped with a 
Rhodium (Rh) X-ray tube, six analyzing crystals (LiF220, LiF200, 
LiF420, PE002, PX1, TlAP), three collimators (150 μm, 550 μm, and 700 
μm), four filters (Al 200 μm, Al 750 μm, Brass 100 μm, Brass 400 μm), 
and two detectors (a gas-flow counter and a scintillation detector), at the 
DiSTAR laboratories. Calibration was performed using 45 certified 
reference materials (Jochum and Enzweiler, 2014), and data acquisition 
was carried out with the SuperQ software. Analytical uncertainties are 
approximately 1–2 % for major elements and 5–10 % for trace elements. 
For XRF analyses, powder samples were prepared as pressed pellets. Loss 
on Ignition (L.O.I.) was determined by first drying the samples overnight 
at 105 ◦C to remove adsorbed moisture (H2O− ), followed by calcination 
in a furnace at 1050 ◦C for approximately 4 h.

2.11. Mercury intrusion porosimetry

Mercury Intrusion Porosimetry (MIP) tests were performed using a 
Thermo Finnigan Pascal Hg porosimeter equipped with 140 and 440 
devices. The first one applies low mercury pressure up to 400 kPa to 
introduce mercury into the sample and measure macroporosity. The 
second one applies a maximum pressure of 400 MPa for mesoporosity 
measurement, corresponding to a minimum measurable pore diameter 
of about 0.003 μm (ISO 15901-1:2016 (ISO 15901-1 2016)). Small but 
representative fragments (bulky volumes ≈1cm3), were selected, 
avoiding any changes in the natural distribution of the porous space. The 
samples were then dried for 24 h in a vacuum oven at ~70 ◦C before 
being analysed. Data were processed by SOL.I⋅D (Solver of Intrusion 
Data), software (Ver. 1.6.6. – Thermo Scientific), allowing to determine 
apparent and bulk densities, Hg-open porosity, total pore-surface area, 
and average, and modal pore diameter. Three measurements were the 
minimum number of average data for pore-size distribution curve (Fig 

1S).

3. Results and discussion

3.1. Results: CR-39 survey

The results of the indoor radon activity concentration measurement 
campaign confirmed the high values hypothesized based on the avail
able geo-lithological information about the village of Sant'Agata de' 
Goti. Table 1 shows the results for the two exposure periods. The first 
period, from 18/07/23 to 20/11/23, encompasses the warmer months, 
while the second period, from 20/11/23 to 31/05/24, covers the colder 
period of the year, during which indoor radon levels generally tend to be 
higher. Radon activity concentrations values are reported along with the 
uncertainties, as calculated with the GammaVision Software 
(GammaVision®). Uncertainty is calculated as the square root of 
quadrature summing of all individual uncertainties from the analysis, 
including counting uncertainty, nuclide uncertainty and efficiency un
certainty. A comprehensive description can be found in the software 
manual, available in (GammaVision®).

As reported in Table 2, the median of measured values is 363 Bq/m³, 
the maximum reported value is 1164 ± 120 Bq/m³, the minimum value 
is 87 ± 12 Bq/m³, and the mean of the reported activity concentration 
values is 395 ± 210 Bq/m³. This mean value exceeds the reference level 
of 300 Bq/m³ indicated by current regulations.

Rather than the high mean value, susceptible to the influence of 
potential outliers, what is noteworthy is that results are homogeneous, 

Table 1 
Results of radon gas concentrations for each room, floor, and time. The measurement uncertainty is expressed as expanded uncertainty with coverage factor k = 2 (95 
% confidence interval). Tuff rooms in the basement are shown in green; tuff rooms on the ground floor are shown in blue; tuff rooms and the first floor are shown in 
yellow; and concrete rooms are shown in gray.

Intended use Code Building materials Wall covering Floor Radon activity PERIOD I (Bq/m³) Radon activity PERIOD II (Bq/m³)

Ecclesiastical structure I S1 Tuff Plaster − 1 542 ± 57 509 ± 53
Ecclesiastical structure I T1 Tuff Plaster 0 362 ± 40 390 ± 41
Ecclesiastical structure I T2 Tuff Plaster 0 182 ± 22 441 ± 43
Ecclesiastical structure II S2 Tuff Plaster − 1 378 ± 41 330 ± 35
Ecclesiastical structure II S3 Tuff Plaster − 1 402 ± 44 319 ± 34
Ecclesiastical structure II P1 Tuff Plaster 1 399 ± 43 376 ± 40
Ecclesiastical structure II T3 Tuff Plaster 0 251 ± 28 272 ± 29
Ecclesiastical structure II P2 Tuff Plaster 1 456 ± 49 461 ± 48
Private study T4 Tuff Plaster 0 363 ± 40 363 ± 39
Commercial activity T5 Tuff Plaster 0 467 ± 50 493 ± 52
Public office T6 Tuff Plaster 0 334 ± 37 346 ± 37
Commercial activity T7 Tuff Wood 0 558 ± 59 869 ± 89
Commercial activity T8 Tuff Plaster 0 87 ± 13 137 ± 16
Commercial activity T9 Tuff Tuff 0 345 ± 38 332 ± 36
Underground cavity S4 Tuff Tuff − 1 1164 ± 120 943 ± 97
Church T10 Tuff Plaster 0 297 ± 33 470 ± 49
Ecclesiastical structure III T11 Tuff Plaster 0 481 ± 51 391 ± 41
Ecclesiastical structure III T12 Concrete Plaster 0 142 ± 18 268 ± 29
Ecclesiastical structure III T13 Tuff Plaster 0 234 ± 27 298 ± 32
Ecclesiastical structure III T14 Concrete Pvc panels 0 87 ± 12 270 ± 29

Table 2 
Some statistical indicators on reported indoor radon concentration 
measurements.

Mean concentration across all measurements 395 Bq/m3

Mean concentration in tuff buildings 417 Bq/m3

Median 363 Bq/m3

Minimum reported concentration 87 ± 12 Bq/ 
m3

Maximum reported concentration 1164 ± 120 
Bq/m3

% of measurements exceeding the reference level of 300 Bq/m³ 
(Legislative Decree 1010/2020)

70 %

% of measurements not significantly different from the reference 
level of 300 Bq/m³ (considering measurement uncertainty)

15 %

% of measurements below the reference level 8 %
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with 70 % of the measurements exceeding 300 Bq/m³ as shown in Fig. 2.
The high percentage of indoor environments with values exceeding 

300 Bq/m³ suggests that the municipality could be classified as a priority 
area for radon risk according to the PNAR (Currie, 1968). It would be 
sufficient for 15 % of 16 measurement points to exceed 300 Bq/m³ to be 
classified as a priority area. This study found that about 70 % of the 20 
measurement points exceeded the reference value. Detailed discussion 
of the results for each environment is reported in supplementary (2.S 
CR-39 Survey results discussion).

Indoor radon activity concentrations typically increase during winter 
(Di Carlo et al., 2023; Pulinets et al., 2024). This trend was observed in 
13 of the 20 measurement points. While an inversion was noted in the 
remaining 7, the differences were small and within measurement error. 
This could be due to an exceptionally hot summer leading to increased 
use of air conditioning and a mild winter encouraging ventilation. 
However, the inversion in 3 measurement points within the same 
ecclesiastical structure, as well as in the tuff cellar (S4), may indicate 
that the buildup of indoor radon is predominantly attributed to the 
construction materials used rather than to the influx of radon from 
beneath the ground. Specifically, the diffusion of radon from BMs is 
enhanced under conditions of high temperature. Conversely, the accu
mulation of radon from subsurface sources is augmented by an 
increasing temperature gradient between the indoor and outdoor areas, 
particularly during winter months. Several studies reported that the 
seasonal trend reversal can be attributed to convective flows of 
radon-bearing air, which, through permeable soil, can reach indoor 
environments, especially those developed on elevated areas positioned 
on pyroclastic soil (Di Carlo et al., 2023; Moreno et al., 2024).

However, paired t-test has been performed to evaluate seasonal dif
ferences between radon period I (warmer months) and period II (colder 
period). The calculated p-values 0.1935 was found to be greater than the 
critical value of 0.05, indicating a lack of significance. There is no sig
nificant difference in radon concentrations during the two period of 
analysis; they remain closely similar to each other. This observation can 
be attributed to the well-known natural thermal insulation properties of 
the tuff

3.2. Results: gamma spectrometry

Gamma spectrometry analysis was conducted on three distinct types 
of tuffs from Sant'Agata de' Goti. Three samples were analyzed for each 
tuff type. The mean activity concentrations of Ra-226, Th-232, K-40, and 
used to calculate index I, as shown in Table 3. These results were then 
compared to previously reported values for similar types of tuffs in 
literature.

The measured specific activities of tuff samples align with literature 
values, supporting the classification of the material. Variations within 
the same tuff type might be attributed to distinct lithological zones at 
different sampling sites. The results indicate that the grey tuff from 

Sant'Agata de' Goti poses potential radiation protection concerns.

3.3. Results: exhalation

Table 4 shows the mean values of parameters useful for calculating 
exhalation and emanation of the three samples for each type of tuff, 
SADG1 and SADG2.

The duration of measurements and the radon background were the 
same in all cases. Similarly, volume and surface area were kept more or 
less constant for the two types of sample states (rock or powder). The 
variable parameters for each type of sample were radon activity con
centration and mass.

Table 5 shows the results for η, R, Rm, Rs These values were compared 
with those documented in literature for similar types of grey tuffs from 
the Campania region (Sabbarese et al., 2021). The uncertainty of each 
value is about 10 %.

Radon emanation and exhalation from tuff are not solely determined 
by 226Ra. Petrographic characteristics, such as grain size and porosity, 
also play a significant role. The high emanation/exhalation potential of 
the Sant'Agata de' Goti tuff, more than its high radionuclide levels, 
suggests a risk of elevated indoor radon levels. The high indoor radon 
concentrations observed in this study are likely attributed to the con
struction materials, in addition to the fluxes from the subsoil (Di Carlo 
et al., 2023).

Additionally, this research aimed to investigate whether the process 
of pulverizing construction materials influences their emanation and 
exhalation properties. Many measurement techniques require samples 
to be powdered, which, as our results indicate, can lead to an over
estimation or underestimation of the actual radon emissions from these 

Fig. 2. Results of the individual measurements for each room and for each period - warm (W) and cold (C) - in relation to reference level of the legislation.

Table 3 
Results of gamma spectroscopy measurements and calculation of I for both 
samples of this study (SADG) and samples of the same type in literature. * In
dicates values calculated by authors.

Ra-226 
(Bq/ 
kg)

Th-232 
(Bq/kg)

K-40 
(Bq/kg)

I 
index

SADG1 104 ±
10

190 ± 19 1301 ±
130

1.73

SADG2 105 ±
10

181 ± 18 1233 ±
123

1.66

Grey tuff (1) in (Nuccetelli et al., 
2017)

79 ± 3 106 ± 6 1387 ±
52

1.26

Grey tuff (2) in (Nuccetelli et al., 
2017)

90 ± 4 102 ± 6 1945 ±
70

1.46

Grey tuff (Tuoro-Caserta) in (
Nuccetelli et al., 2017)

107 ±
4

121 ± 6 1740 ±
61

1.54*

Grey tuff in (Sabbarese et al., 
2021)

85 ± 3 106 ± 6 1747 ±
61

1.39*

Grey tuff in (Nuccetelli et al., 
2017)

243 542 1925 4.16
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materials. The primary cause of this variation in values is attributed to 
the drastic change in porosity, although a change in grain moisture 
content, which significantly influences the emanation coefficient, may 
also contribute (Sakoda et al., 2010).

For all samples, exhalation and emanation parameters increase when 
transitioning from rock to powder, as expected (Zheng et al., 2024); 
notably, η and Rm increase by 72 %, and Rs by 285 % for SADG1 sample, 

whereas η and Rm increase by 99 %, and Rs by 300 % for SADG2.

3.4. Results: mineralogical, petrographic and porosimetry 
characterization

Mineralogical and petrographic characterizations were carried out 
on lithotypes (samples SADG1 and SADG2) that exhibiting similar fea
tures to those used in the construction of the historic buildings and 
shows radiometric anomalies. Petrographic analyses were performed on 
thin sections, whereas rock fragments were investigated for mineral 
morphological features and qualitative chemical composition using 
SEM-EDS. Bulk-rock quantitative chemical analyses were also carried 
out using XRF. Calcination was performed on the samples to determine 
their Loss on Ignition (LOI). It is important to note that the mineralogical 
characterization presented in this study is based on petrographic mi
croscopy and SEM-EDS analyses. Although X-ray diffraction (XRD) is a 
widely employed technique for quantitative mineral identification, 
previous studies on the Campanian Ignimbrite facies have demonstrated 
that zeolitic phases (mainly phillipsite, with subordinate smectite), 
when restricted to small microdomains or vesicle infillings, frequently 
occur in concentrations below the typical XRD detection limit (≈3–5 wt 
%). This observation is consistent with our thin-section and SEM results, 

Table 4 
Parameters of the measurements and physical characteristics of the samples.

Duration of measurements (days) Radon background 
(Bq/m3)

Radon activity concentration 
(Bq/m3)

Volume 
(m3)

Surface area 
(m2)

Mass 
(kg)

SADG1 rock

5 10

180 0.000077513 0.0148088 0.10324
SADG1 powder 210 0.000063478 0.00453416 0.07082
SADG1 rock 178 0.000077513 0.0148088 0.12324
SADG2 powder 215 0.000063478 0.00453416 0.07582

Table 5 
Results of η, R, Rm, Rs calculation both samples of this study (SADG) and of 
samples of the same type in literature.

η 
(%)

R 
(Bq/ 
d)

Rm 

(Bq/ 
(kg⋅h))

Rs 

(Bq/ 
(m2⋅h))

SADG1 (rock) 15 0.31 0.12 0.85
SADG1 (powder) 27 0.36 0.21 3.31
SADG2 (rock) 12 0.30 0.10 0.34
SADG2 (powder) 25 0.37 0.20 3.39
Grey tuff rock (1) in (Jochum and 

Enzweiler, 2014)
8 // 0.05 0.91

Grey tuff rock (2) in (Jochum and 
Enzweiler, 2014)

12 // 0.08 1.56

Fig. 3. A) Thin-section image under polarized light showing lithic fragments (pumiceous and carbonate) and the glassy matrix of the tuff; B) Thin-section image 
under polarized light illustrating carbonate lithic fragments containing visible planktonic foraminiferal shells; C) SEM micrograph of zeolitized pumice and/or glass 
displaying adularia crystals and smectite, as supported by qualitative SEM–EDS analyses; D) SEM micrograph showing vesicles and microfractures connecting pu
miceous clasts.
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which reveal a localized yet overall limited degree of zeolitization 
within pumice fragments. Consequently, XRD analysis would likely not 
significantly alter the qualitative mineralogical interpretation proposed 
here. Nonetheless, future work will include XRD analyses on an 
expanded dataset to further refine the quantitative relationship between 
secondary mineral phases and radon emanation behavior

The SADG1 sample is a greyish rock with relatively fine grain, con
taining scattered pumiceous, scoriaceous, and lithic lapilli. Studies 
conducted on thin sections reveal a dark pumiceous and scoriaceous 
lapilli, often rounded (Fig. 3A and B), along with fragments of feldspar 
and clinopyroxene crystals. Additionally, numerous lithic fragments of 
carbonate nature are observed, in which planktonic foraminifera shells 
are visible (Fig. 3B). Rarely, in some pumice cavities, philipsite and 
adularia crystals are found, as well as smectite, as identified by SEM-EDS 
analysis (Fig. 3C). Observations of microstructural features indicate a 
well-developed primary porosity, with vesicles and microfractures 
connecting pumiceous and scoriaceous clasts (Fig. 3D). These features 
suggest differences in pore connectivity across the sample, which could 
influence radon diffusion and emanation.

Chemically, XRF analyses (Table 6) show a high concentration of 
CaO and Sr, at 13.35 wt % and 1345 ppm respectively, with an unusually 
high LOI for this type of material (16.76 wt %). This is attributed to the 
significant presence of carbonate lithic fragments. Elevated concentra
tions of Th and U, at 92 ppm and 30 ppm respectively, are also noted 
(Table 6). Based on bibliographic data regarding geochemical, miner
alogical, and petrographic descriptions, the sample could originate from 
the WGI-LYT transition zone (Langella et al., 2013; Scarpati et al., 2020; 
Pappalardo et al., 1999), although discrepancies remain in the Th and U 
contents found in the chemical analyses (Fedele et al., 2008; Arienzo 
et al., 2011; Belkin et al., 2016).

The SADG2 sample is a yellowish fine-grained rock with dispersed 
pumiceous and lithic lapilli. Studies conducted on thin sections reveal 
the presence of large pumice lapilli and smaller, darker scoriaceous and 
lithic fragments (Fig. 4a). Fragments of feldspar and clinopyroxene 
crystals are present. Moreover, elongated zeolite crystals, likely 

philipsite, are widespread and clearly visible within a pumice void 
(Fig. 4b and c). SEM-EDS analyses confirm the presence of philipsite 
crystals, which are often associated with an alteration patina of smectite 
and large fragments of sodium-rich plagioclase (albite, Fig. 4d). Micro
structural observations of SADG2 indicate interconnected vesicles and 
primary porosity within pumice clasts, as well as microfractures that 
may facilitate gas transport. These qualitative observations provide in
sights into the potential pathways for radon diffusion. XRF analyses 
show a high concentration of CaO and Sr, at 12.15 wt % and 1589 ppm 
respectively; Na2O levels are also significant (2.21 wt %). In this case as 
well, anomalous LOI values were detected. The high values of CaO and 
LOI are related to carbonate lithic fragments and zeolites (Langella et al., 
2013); the higher levels of Na2O are likely linked to the presence of 
Na-rich philipsite and large albite fragments (Fig. 4c and d). Chemical 
analyses also show elevated levels of Th and U (Fedele et al., 2008; 
Arienzo et al., 2011; Belkin et al., 2016), at 117 ppm and 18 ppm 
respectively (Table 6). Based on the mineral-petrographic description 
and geochemical analyses, the studied rock can be attributed to the 
lithified yellow tuff unit (Langella et al., 2013; Scarpati et al., 2020).

The mercury intrusion porosimetry (MIP) analysis performed on 
samples SADG1 and SADG2 provides quantitative evidence supporting 
the petrographic observations on vesicularity and microstructural con
nectivity. Both tuffs exhibit high total porosity, equal to 44.79 % for 
SADG1 and 46.97 % for SADG2, consistent with the widespread pres
ence of primary vesicles and microfractures within pumice and scoria
ceous clasts described in Campanian Ignimbrite facies (Langella et al., 
2013; Scarpati et al., 2020; Allocca et al., 2022). Total pore volume 
values (0.338 and 0.363 cm³/g for SADG1 and SADG2, respectively) 
align with the abundance of vesiculated pumice fragments observed in 
thin section and SEM analyses. The higher total pore surface area 
measured in SADG2 (6.785 m²/g versus 4.908 m²/g in SADG1) is 
consistent with its more pervasive zeolitization and the widespread 
presence of philipsite and smectite infillings (Cappelletti et al., 2003; Di 
Benedetto et al., 2015), which are known to increase the internal surface 
area of altered ignimbrites. Differences in average and modal pore di
ameters (SADG1: 0.276 µm and 1.883 µm; SADG2: 0.214 µm and 4.3 µm) 
reflect contrasting degrees of vesicle coalescence and secondary mineral 
overgrowth, in agreement with the variability reported for welded and 
lithified tuff facies (Scarpati et al., 2020). Overall, the porosimetric 
parameters strongly support mineralogical and petrographic observa
tions, confirming that the studied tuffs possess a highly porous and 
microfractured framework characteristic of Campanian Ignimbrite ma
terials (Cappelletti et al., 2003; Langella et al., 2013).Table 7

4. Conclusion

The correlation between the different experimental methods enabled 
a synergistic data interpretation, strengthening the overall risk assess
ment. Radon concentration measurements obtained using CR-39 de
tectors revealed values exceeding the regulatory threshold in 70 % of the 
monitored sites (Kemski et al., 2012). These results are consistent with 
those obtained through E-PERM measurements, which confirmed a high 
exhalation capacity of the local tuff (Koumantakis et al., 2017). This 
suggests a clear relationship between the properties of the building 
materials and the accumulation of radon in indoor environments 
(Turhan et al., 2017). Furthermore, gamma spectrometry quantified 
high specific activities of Ra-226 and Th-232, in agreement with 
thorium and uranium concentrations determined via XRF (Chen et al., 
2018). This supports the hypothesis that the materials studied represent 
a primary source of radon (Al-Harthy et al., 2016). Results of Th-232 
have shown measured activity concentration values almost by a factor 
2 times higher compared to Ra-226. This fact highlights the crucial 
contribution of Rn-220 to indoor radon, coming from building materials. 
Measuring and modeling Rn-220 exhalation could be crucial for 
assessing total indoor radiation risk, especially in areas with volcanic 
geology.Thorium and Uranium concentrations measured in the tuff 

Table 6 
Average chemical analyses of CI facies.

SADG1 SADG2

SiO2 53.02 53.20
TiO2 0.57 0.58
Al2O3 16.26 16.17
Fe2O3 3.96 3.86
MnO 0.13 0.15
MgO 1.66 1.46
CaO 13.35 12.15
Na2O 0.85 2.21
K2O 9.88 9.96
P2O5 0.09 0.10
TOT 99.77 99.84
LOI* 16.76 16.39
Rb 360 409
Sr 1345 1587
Y 42 427
Zr 532 5807
Nb 38 42
Ba 817 974
Cr 27 5
Ni 26 22
Sc 11 5
V 152 76
Co 3 3
Cu 11 12
Zn 99 99
Ga 22 19
Hf 12 13
Ta 3 3
Pb 148 155
Th 92 117
U 30 18
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samples are relatively high, and, on average, exceed the values 
commonly reported in literature for similar materials. Nevertheless, 
they are consistent with the Campanian Ignimbrite origin and the tra
chyphonolitic composition of the volcanic products, as documented in 
comparable facies (Langella et al., 2013; Arienzo et al., 2011). This is 
particularly true for zeolitized or altered facies, where uranium and 
thorium may be hosted in devitrified glassy matrices, secondary min
erals such as smectite and phillipsite, or accessory phases (Arienzo et al., 
2011; Belkin et al., 2016). Mineralogical and textural observations 
indicate that the studied tuffs possess well-developed primary porosity, 
vesicles, and microfractures, with zeolitic phases (phillipsite) and 
smectites filling some voids. These microstructural features suggest 
variations in pore connectivity and effective porosity, which can 
significantly influence radon diffusion and emanation. The data there
fore indicate that microstructural and mineralogical characteristics may 
play a more important role in radon release than radionuclide concen
tration alone (Buzcu-Guven et al., 2014; Giusti et al., 2013). Anomalous 

behavior was observed in SADG2 (see section on Electret Ion Chamber), 
where pulverization led to a decrease, rather than an increase, in 
exhalation parameters. This phenomenon might be attributable to the 
higher LOI, as well as zeolitized pumices and fossiliferous carbonate 
clasts, which may reduce effective porosity and hinder radon transport 
in the powdered form (Kojima et al., 2011). The porosimetric results 
substantially reinforce the interpretation of radon behaviour by 
demonstrating the key role of microstructural features in controlling 
emanation and exhalation dynamics. High porosity values (≈45–47 %), 
together with connected pore networks in the micrometric range, create 
highly efficient pathways for radon transport, as already highlighted in 
studies linking ignimbrite vesicularity to gas mobility (Sakoda et al., 
2010; Cappelletti et al., 2003). The higher pore surface area in SADG2 
correlates with its more significant zeolitization, a process known to 
modify effective porosity and internal surface geometry (Langella et al., 
2013), while the presence of secondary minerals such as philipsite and 
smectite may further influence radon retention and release (Arienzo 
et al., 2011; Belkin et al., 2016). These microstructural characteristics 
provide a mechanistic explanation for the elevated radon emanation 
coefficients observed in powdered samples and are consistent with the 
higher indoor radon concentrations detected in buildings constructed 
with these tuffs (Di Carlo et al., 2023; Turhan et al., 2017). The inte
gration of petrographic, radiometric, and porosimetric data therefore 
confirms that the intrinsic physical fabric of the Campanian Ignim
brite—characterised by high vesicularity, microfracturing, and 
zeolite-rich alteration domains—plays a primary role in radon genera
tion and mobility, often exerting a stronger influence than radionuclide 
content alone (Nuccetelli et al., 2020; Moreno et al., 2024). Finally, the I 
index exceeded the regulatory threshold in two of the analyzed tuff 

Fig. 4. A) Thin-section image under polarized light showing large pumice lapilli associated with smaller, darker scoriaceous and lithic fragments; B) Thin-section 
image under polarized light revealing abundant elongated zeolite crystals—likely phillipsite—clearly visible within a pumice vesicle; C) SEM micrograph showing 
large phillipsite crystals with Na-rich composition indicated by qualitative SEM–EDS analyses, along with smectite within pumice vesicles; D) SEM micrograph of 
large albite crystal fragments and phillipsite within vesicles (highlighted in yellow). Mineralogical identification is supported by qualitative SEM–EDS data.

Table 7 
Porosity data of ignimbrites measured by mercury intrusion porosimetry (MIP).

SADG1 SADG2

Total pore surface area (m2/g) 4.908 6.785
Bulk density (g/cm3) 1.3245 1.2946
Apparent density (g/cm3) 2.3989 2.4415
Total pore volume (cm3/g) 0.33813 0.36283
Average pore diameter (µm) 0.2756 0.2139
Modal pore diameter (µm) 1.883 4.3
Porosity by Hg intrusion (%) 44.79 46.97
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types. This evidence, combined with the observed high exhalation po
tential, confirms the need to consider existing building materials in the 
planning of mitigation strategies outlined in the PNAR. The integration 
of the adopted analytical techniques thus enables the proposal of tar
geted mitigation interventions, grounded in quantitative and scientifi
cally validated data. Despite the complexity of adopting remedial 
actions (Hodgson et al., 2011), which does not allow for an instant so
lution, increased passive ventilation (e.g., window opening times and 
openings to the outside) has been prescribed. The next step will be to 
conduct further radon gas monitoring to verify the effectiveness of this 
remedial action and, if not, proceed with the evaluation of structural 
interventions, consistent with legislative and/or regulatory constraints.
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